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Cap. 1. Prezentarea generală a unei baze de date 
 

1.1. Conceptul de bază de date 
În cea mai simplă formă, o bază de date reprezintă o colecţie de informaţii 

care este organizată într-o listă. De fiecare dată când realizăm o listă de informaţii, 
cum ar fi nume, adrese, produse sau facturi, se crează, de fapt, o bază  de date.  

O bază de date constă, deci, într-un ansamblu structurat de date înregistrate 
pe suporturi accesibile calculatorului pentru a satisface simultan mai mulţi utilizatori 
de o manieră selectivă şi într-un timp oportun. 

Tehnic vorbind, nu este neapărat necesar să utilizăm un program de baze de 
date pentru crearea unei astfel de colecţii de date. Putem crea o listă de informaţii 
utilizând o mare varietate de programe, cum ar fi Microsoft Excel, Microsoft Word, 
chiar aplicaţia Notepad din Windows. 

Spre deosebire de acestea, însă, un program de baze de date este mult mai 
puternic decât o simplă listă pe care o păstrăm pe o hârtie sau în cadrul unui 
document Word. Un program de baze de date oferă celui care îl utilizează diverse 
avantaje în plus, cum ar fi: 

 Stocarea informaţiilor: o bază de date păstrează colecţii de date şi 
informaţii care sunt legate de un anumit domeniu. Aceste colecţii pot conţine 
informaţii personale sau informaţii de afaceri. În plus, odată cu stocarea 
acestor informaţii, o bază de date trebuie să ofere posibilitatea de a adăuga noi 
date, de a le modifica sau şterge pe cele existente sau de a le organiza în 
funcţie de diverse criterii. 

 Căutarea informaţiilor: orice aplicaţie de baze de date trebuie să dea 
posiblitatea celui care o utilizează să regăsească informaţiile conţinute de 
aceasta cu uşurinţă şi foarte rapid. Astfel, otţi producătorii de astfel de aplicaţii 
sunt preocupaţi de minimizarea pe cât posibil a timpului de acces la datele 
conţinute de către bazele de date. 

 Analiza şi imprimarea informaţiilor: într-o bază de date se pot 
efectua diverse calcule, care ulterior pot forma diverse situaţii ce pot fi 
prezentate sub forma unor rapoarte pe suport de hârtie. 

 Partajarea informaţiilor: cele mai multe programe de baze de date 
permit lucrul simultan cu baza de date a mai multor utilizatori, care pot utiliza 
aceeaşi informaţie în acelaşi timp. Astfel de baze de date poartă denumirea de 
baze de date multiuser sau multiutilizator. 

 
Un program sau aplicaţie care oferă posibilitatea lucrului cu baze de date cu 

toate avantajele prezentate anterior poartă denumirea de Sistem de Gestiune a 
Bazelor de Date, prescurtat S.G.B.D. El permite lucrul cu mai multe baze de date, în 
acelaşi format, de unde şi denumirea de sistem de gestiune. Un astfel de SGBD 
este şi aplicaţia Microsoft Access, distribuită de către firma Microsoft în pachetul de 
aplicaţii Office. Ne vom referi în prezentul curs la versiunea 2002 a acestei aplicaţii, 
inclusă în pachetul Microsoft Office 2002 sau XP. 
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1.2. Elementele unei baze de date Microsoft Access 
O bază de date Microsoft Access este alcătuită din mai multe părţi 

componente, pe care le vom numi obiecte ale bazei de date. Unele obiecte sunt 
folosite totdeauna (fără ele baza de date nu poate exista), iar altele pot fi utilizate 
ocazional. Fiecare din aceste obiecte au funcţii diferite, urmărind realizarea 
avantajelor prezentate mai sus, sau realizarea unei interfeţe cât mai agreabile 
pentru utilizator, astfel încât să uşureze pe cât posibil lucrul cu baza de date. 
Următorul tabel identifică şi prezintă obiectele conţinute de către o bază de date 
Access XP: 

 
 

Obiect Descriere 

 Tabele 

Sunt utilizate pentru a asigura funcţia de stocare a 
informaţiilor omogene în cadrul bazelor de date, fiind 
alcătuite din rânduri (înregistrări) şi coloane (câmpuri). O 
bază de date trebuie să conţină cel puţin un tabel pentru 
a exista. Celelalte obiecte sunt opţionale. 

 Interogări 

Oferă posibilitatea căutării şi regăsirii rapide a 
informaţiilor stocate în tabele, prin chestionarea bazei de 
date. Ele pot fi comparate cu anumite întrebări care i se 
pun bazei de date  şi ca care aceasta trebuie să 
răspundă. 

 Formulare 

Sunt ferestre din ecranul calculatorului, care pot fi 
personalizate pentru a prezenta datele conţinute în 
tabele sau interogări sub o formă uşor de înţeles. Ele 
dau şi posibilitatea actualizării datelor din tabele, în 
sensul că orice modificare efectuată la nivelul lor aduce 
după sine modificarea informaţiilor stocate în tabele. 

 Rapoarte 
Prezintă datele din tabele sau interogări într-o formă 
care poate fi imprimată pe suport de hârtie. 

 Pagini web 
Un tip special de pagină web, destinată afişării cu 
ajutorul Internetului sau Intranetului a datelor conţinute 
într-o bază de date Access 

 Macrocomenzi 

Permit efectuarea unor sarcini de rutină, prin 
automatizarea acestora într-o singură comandă, care 
poate fi apelată mult mai uşor de fiecare date când este 
necesar. 

 Module 

Sunt utilizate pentru automatizarea unor operaţii, la fel 
ca şi macrocomenzile, însă utilizează un limbaj de 
progamare pentru aceasta, ele fiind accesibile celor care 
dispun de cunoştinţe de programare. 

 
Toate aceste obiecte prezente în cadrul unei baze de date Microsoft Access pot fi 
utilizate împreună; uneori chair depind unele de altele. Însă împreună pot crea o 
aplicaţie foarte bine structurată şi care poate fi utilizată chiar la nivelul unor instituţii 
mari. 
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1.3. Deschiderea aplicaţiei Microsoft Access, crearea unei baze de 
date noi, deschiderea unei baze de date existente. 

 
Pentru a putea începe lucrul cu baze de date, trebuie să deschidem mai întâi 

aplicaţia Microsoft Access. Dacă pe calculatorul pe care lucraţi există instalat 
pachetul Microsoft Office, atunci puteţi deschide aplicaţia Access prin apăsarea 
butonului Start, apelarea meniului Programs, apoi căutarea şi apelarea opţiunii 
Microsoft Access.  

 
 
 
 
 
 
 
 
 
 
 
 
 

O altă posibilitate de deschidere a acestei aplicaţii ar fi efectuarea unui dublu clic pe 
pictograma Microsoft Access de pe desktop-ul calculatorului dumneavoastră, în 

cazul în care aceasta există. Această pictogramă desemnează, de fapt, o 
scurtătură (în engleză, Shortcut) către programul Microsoft Access, numit 
MSAccess.exe situat pe discul C, în directorul Program Files\Microsoft 
Office\Office10.  

 
La deschiderea aplicaţiei Access apare o fereastră cu o bară de meniuri, una 

sau mai multe bări de instrumente (Toolbars) precum şi o fereastră de sarcini, 
numită Task Pane (panou de sarcini). Acest panou ne oferă posibilitatea de creare a 
unei noi baze de date sau de deschidere a unei baze de date existente deja într-o 
anumită locaţie din calculatorul dumneavoastră sau dintr-un alt calculator aflat în 
reţeaua locală pe care puteţi s-o accesaţi. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bara de 
meniuri 

Bara de 
instrumente 

Panoul de 
sarcini 



Baze de date – Microsoft Access 

Pagina 5 din 42 

Pentru crearea unei noi baze de date alegeţi opţiunea Blank Database din 
partea dreaptă a ferestrei aplicaţiei. Se va deschide o fereastră de dialog în care 
puteţi preciza locaţia în care va fi salvată baza de date precum şi numele fişierului 
aferent bazei de date, fişier ce poartă extensia mdb. 

Pentru a deschide o bază de date creată deja, avem două posibilităţi. Prima 
este alegerea din lista de fişiere accesate anterior pe care Access o pune la 
dispoziţie în partea dreaptă a aplicaţiei. Cea de-a doua posibilitate constă în 
efectuarea unui clic pe opţiunea More files din panoul de sarcini din partea dreaptă 
a aplicaţiei sau în apelarea meniului File->Open. Se va deschide imediat o fereastră 
denumită Open, care ne oferă posibilitatea de a alege fişierul bazei de date pe care 
dorim să o accesăm. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

După alegerea fişierului bazei de date se apasă butonul Open pentru a 
deschide baza de date respectivă. 

Atât la crearea unei baze de date noi cât şi la deschiderea uneia deja 
existente, în cadrul ferestrei aplicaţiei Microsoft Access se va deschide o altă 
fereastră, denumită fereastra activă a bazei de date, care va conţine toate obiectele 
specifice bazei de date în cauză. Acestă fereastră serveşte la vizualizarea şi 
modificarea tuturor elementelor componente ale bazei de date, grupate pe tipuri de 
obiecte (tabele, interogări, formulare, rapoarte, pagini web, macrocomenzi şi 
module). 

Schimbarea 
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Bara de instrumente specifică ferestrei bazei de date conţine trei butoane 
importante, pe care le întâlnim la toate tipurile de obiecte:  

 Butonul Open: Deschide obiectul selectat din cadrul zonei 
active a ferestrei bazei de date, pentru vizualizarea conţinutului 
acestuia; Pentru unele tipuri de obiecte, acest buton este înlocuit cu 
butonul Run sau Preview; 

 Butonul Design: Deschide obiectul selectat pentru modificarea 
modului de proiectare a acestuia; 

 Butonul New: Crează un nou obiect de tipul selectat în partea 
stângă a ferestrei. 

 
Fiecare bază de date dispune de obiecte proprii, numai tipurile de obiecte 

sunt aceleaşi pentru toate bazele de date. 
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Cap. 2. Obiecte de tip tabel într-o bază de date Access 
 

2.1. Crearea obiectelor de tip tabel 
 

Orice bază de date trebuie să conţină cel puţin un tabel. Obiectele de tip 
tabel ale unei baze de date Microsoft Access sunt alcătuite din rânduri şi coloane, 
ele fiind numite şi relaţii. O relaţie este o tabelă bidimensională, ale cărei rânduri 
sunt denumite înregistrări  sau tupluri şi ale cărei coloane poartă denumirea de 
câmpuri sau domenii ale relaţiei.  

Orice relaţie trebuie să deţină informaţii cu privire la un anumit aspect din 
realitate. În acest sens, câmpurile relaţiei trebuie să exprime, de fapt, proprietăţi ale 
relaţiei în cauză. De exemplu, pentru relaţia sau tabelul Salariaţi pot fi definite 
următoarele câmpuri, care exprimă şi proprietăţi ale unui salariat: Marca, Nume, 
Prenume, Data nasterii, Salariul de incadrare.  

Înregistrările unui tabel constau, de fapt, în valori ale câmpurilor pentru o 
anumită realizare a relaţiei în cauză. De exemplu, pentru tabelul Salariati, o 
înregistrare ar putea fi: M154200, Ionescu, Petre, 21.05.1967, 5000000.  

Pentru a defini un nou tabel care să grupeze informaţii omogene, trebuie, mai 
întâi, să înţelegem semnificaţia anumitor termeni utilizaţi în cadrul acestuia: 

 Cheia primară a unui tabel sau relaţie reprezintă acel câmp sau 
grup de câmpuri ale relaţiei, ale căror valori pot identifica, în mod 
unic, valorile celorlalte câmpuri din cadrul aceleiaşi înregistrări. De 
exemplu, marca salariatului poate identifica în mod unic valorile 
pentru celelalte câmpuri (Nume, Prenume, Data nasterii, Salariul 
de încadrare). 

 Cheia externă exprimă acel câmp din cadrul unei relaţii, care, în 
cadrul altui tabel, se regăseşte sub forma unei chei primare. 

 Asocierea dintre două tabele exprimă legătura care se crează 
între cele două relaţii, prin intermediul câmpurilor de legătură cheie 
primară - cheie externă. 

Crearea unui nou tabel constă în parcurgerea anumitor paşi: 
1. Activarea grupului de obiecte de tip tabel prin efectuarea unui clic pe 

opţiunea Tables; 
2. Efectuarea unui clic desupra butonului New de pe bara de instrumente a 

ferestrei bazei de date sau apelarea meniului Insert->Table. Se va 
deschide o fereastră de dialog care ne invită să alegem opţiunea dorită 
pentru crearea tabelului: utilizând modul de proiectare a tabelului 
(Design View), prin introducerea datelor ce vor fi conţinute de tabel 
(Datasheet View), sau prin utilizarea asistentului (Table Wizard), pentru 
parcurgerea unor paşi la finalul cărora se va crea tabelul dorit. 

 
Cea mai utilizată metodă pentru crearea tabelelor Access este apelarea 

modului de proiectare (Design View). Această metodă poate fi apelată şi prin 
efectuarea unui dublu clic pe opţiunea Create table in design view. Ea presupune, 
mai întâi, definirea câmpurilor tabelului respectiv, a tipurilor de câmp şi a 
proprietăţilor fiecărui câmp în parte. De aceea, apelarea acestei metode coincide cu 
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deschiderea unei ferestre pentru proiectarea tabelului, care conţine două panouri 
importante: grila de câmpuri şi panoul de proprietăţi ale fiecărui câmp în parte. 

 

 
În cadrul grilei de câmpuri, vor fi trecute toate denumirile de câmpuri din 

cadrul tabelului respectiv, în fiecare celulă a coloanei Field Name. Pentru fiecare 
câmp în parte este obligatorie precizarea tipului câmpului, adică ce fel de date va 
conţine acesta (de tip text, de tip număr, de tip data calendaristică, etc.). Tipul 
câmpului va fi ales dintr-o listă, în cadrul coloanei Data Type, pentru câmpul a cărui 
denumire se află pe acelaşi rând. Cea de-a treia coloană din cadrul grilei, este 
coloana pentru descrierea câmpului nou introdus (Description). 

Fiecare tabel trebuie să aibă definită o cheie primară în mod obligatoriu. 
Cheia primară poate fi alcătuită fie dintr-un singur câmp, fie din mai multe. Pentru 
definirea unei chei primare, se selectează câmpul sau câmpurile dorite şi apoi se 
apasă butonul (Primary Key) de pe bara de instrumente a aplicaţiei 
Access, sau se apelează opţiunea Primary Key  din meniul Edit. Câmpul 
sau câmpurile care formează cheia primară pot fi recunoscute prin „cheia” care le 
însoţeşte în dreptul capului de rând. 

Pentru salvarea tabelului creat, se apelează meniul File->Save, sau File-
>Save As, după care se va preciza numele sub care va fi salvat. După salvarea 
tabelului în cadrul ferestrei bazei de date va apărea pictograma cu denumirea 
tabelului nou creat, ceea ce indică faptul că acesta este un obiect al bazei de date. 

Vom preciza, în continuare, care sunt principalele tipuri de dată pe care un 
câmp le poate lua, şi care se vor preciza în cadrul coloanei DataType: 

 Text, care admite o lungime maximă a realizării atributului de 255 
caractere. Pentru acest tip de dată, lungimea implicită este de 50 de 
caractere. 

 Memo, utilizat pentru stocarea datelor de tip text, mai precis pentru 
stocarea blocurilor de text de până la 64.000 de caractere. Acest tip de 
dată este recomandat atunci când se doreşte stocarea unei anumite 
descrieri cu privire la elementele unei înregistrări. 

 Number, pentru stocarea datelor de tip numeric, fiind reprezentat de 
mai multe subtipuri: Integer (cu valori cuprinse în intervalul [-32.768, 
32.768]), Long integer (cu valori între -2.147.483.648 şi 
2.147.483.648), Byte (cu valori pozitive între 0 şi 255), Single (cu 7 

Grila de 
câmpuri a 
tabelului

Panoul de 
proprietăţi   

ale cîmpului 
selectat 
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zecimale şi valori între -3,4*1038 şi 3,4*1038), Double (cu 15 zecimale, 
şi valori cuprinse între -1797*1038 şi 1797*1038). 

 Date/Time, utilizat pentru stocarea datelor calendaristice sau de tip 
oră. 

 Currency, (format fix cu patru zecimale, prevenind erorile de 
rotunjire), al cărui nume provine de la semnul monetar ($) pe care îl 
afişează automat înaintea valorii câmpului. 

 Autonumber, caracterizat prin faptul că generează automat o valoare 
numerică de tip Long Integer, prin incrementare au o unitate 
(Increment) sau prin generare aleatoare (Random). 

 Yes/No, tip de dată de tip logic: adevărat sau fals. 
 OLE object,  cu ajutorul căruia există posibilitatea de includere în 

cadrul unei baze de date Access diverse fişiere care stochează 
imagini, sunete sau secvenţe video. 

 Lookup Wizard, tip de dată pentru definirea regulilor pentru 
asigurarea integrităţii bazei de date. 

 

2.2. Proprietăţile atributelor unui tabel 
 

Fiecare câmp din cadrul unui tabel deţine un set de proprietăţi care poate 
diferi pentru două câmpuri, în funcţie de tipul de dată ales pentru fiecare atribut în 
parte. Cele mai importante proprietăţi care pot fi atribuite câmpurilor sunt: 

 Lungimea câmpului (Field Size), care permite modificarea 
dimensiunii implicite corespunzătoare tipului definit. 

 Format, care permite stabilirea formatului de afişare a datelor. 
Această proprietate vizează atribute definite cu tipul numeric, dată 
calendaristică sau logic. Formatul dorit poate fi ales prin selectarea 
dintr-o listă predefinită pentru proprietatea Format. Pentru atributele 
numerice se poate opta pentru următoarele formate de afişare: General 
Number, Currency, Fixed, Standard, Percent, Scientific. În cazul 
atributelor de tip dată calendaristică există formatele: General Date, 
Long Date, Short Date, Medium Date, Long Time, Medium Time, Short 
Time, iar în cazul atributelor logice: Yes/No, True/False, On/Off. Fiecare 
astfel de format prezintă un exemplu pentru vizualizarea sa. 

 Şablonul de introducere a datelor (Input Mask), care permite 
definirea măştilor de introducere a valorilor pentru câmpul respectiv. De 
exemplu, pentru a permite introducerea unui caracter de tip numeric (o 
cifră), masca de introducere trebuie să conţină semnul #, cifra 9 sau 
cifra 0. 

 Eticheta câmpului (Caption) permite definirea unui text care să 
fie afişat la vizualizarea datelor din cadrul tabelului, precum şi în cadrul 
formularelor sau rapoartelor care utilizează inregistrări din tabel. 

 Default Value,  permite definirea unei valori implicite care va fi 
afişată automat pentru câmpul în cauză, în momentul în care se adaugă 
o înregistrare nouă, uşurându-se astfel munca operatorului. 
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 Regulile de validare (Validation Rule), permite definirea 
restricţiilor referitoare la domeniul de valori pe care câmpul respectiv le 
poate lua. Aceste reguli de validare a realizărilor pentru atributul în 
cauză se definesc prin intermediul unor expresii Access. De exemplu:  

 >5000000 and <10000000; 

 „Iaşi” or „Bucureşti”; 

 is not null – nu permite valori nule; 

 <Date() – pentru a permite date calendaristice anterioare 
datei curente; 

 Between 2000 and 5000 – cu valori cuprinse în intervalul 
precizat. 

 Textul de validare  (Validation Text), permite afişarea unui 
mesaj cu textul introdus, în situaţia în care regula de validare, precizată 
la proprietatea Validation Rule, este încălcată. 

 Indexat (Indexed), permite definirea unui fişier index pe atributul 
respectiv. Acest fişier ajută la regăsirea rapidă a datelor din cadrul 
câmpului respectiv. Nu pot fi creaţi indecşi pe atribute de tip Memo. 

 

2.3. Definirea asocierilor standard între tabele 
Pentru accesarea simultană a datelor din mai multe tabele, este necesar să 

se definească asocierile standard dintre acestea. Acestea reprezintă colecţia de 
legături care se stabilesc între o realizarea a unei tabele şi o realizare a tabelei 
asociate. 

Asocierile cele mai des întâlnite ditre două tabele Access sunt cele de tipul 
1:n, adică unei înregistrări ale unei tabele, îi corespund mai multe înregistrări ale 
tabelei asociate. Aceste legături se stabilesc prin intermediul cheilor primare şi a 
cheilor externe aferente lor.  

La baza definirii asocierilor dintre tabele stă conceptul de restricţie de 
integritate referenţială (Referential Integrity), care presupune că o cheie externă 
nu poate lua o valoare atât timp cât acea valoare nu se regăseşte în cadrul cheii 
primare asociate ei. 

Pentru stabilirea asocierilor dintre tabele trebuie apelat meniul Tools-
Relationships, sau prin apăsarea butonului Relationships, de pe 
bara de instrumente standard a aplicaţiei Microsoft Access. 

Se va deschide fereastra Relationships, ce va afişa toate tabele bazei de 
date, între care se stabilesc asocieri. Fiecare tabel este reprezentat printr-un 
dreptunghi în care sunt precizate denumirea acestuia, precum şi toate câmpurile 
conţinute de acesta. Legăturile sau asocierile dintre tabele sunt prezentate sub 
forma unor linii care leagă câmpurile de legătură (Cheie primară  - Cheie externă).  

La vizualizarea pentru prima dată a asocierilor, se deschide fereastra pentru 
afişarea tabelelor (Show table), care permite adăugarea tabelelor pentru crearea 
asocierilor dintre acestea. 
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La apăsarea butonului Add, tabelul sau tabelele selectate vor fi afişate în 

fereastra asocierilor dintre tabele. Urmează definirea efectivă a asocierilor, prin 
precizarea câmpurilor de legătură şi a proprietăţilor atribuite asocierii. Legătura se 
stabileşte între tabela primară (cea care conţine cheia primară a asocierii) şi tabela 
externă (ce conţine cheia externă). 

 
 
Pentru a crea asocierea dintre cele două tabele se procedează astfel: se 

selectează câmpul cheie primară din cadrul tabelei primare; se ţine apăsat butonul 
stâng al mausului şi se glisează până când cursorul acestuia ajunge în dreptul cheii 
externe din tabela externă; se eliberează butonul mausului, urmând să se 
stabilească proprietăţile asocierii, prin precizarea lor în cadrul ferestrei care se 
deschide. 

Acestă fereastră precizează care sunt tabelele asociate, câmpurile de 
legătură din cele două tabele, precum şi tipul asocierii (Relationship Type), care 
poate fi: One to many (corespunzător asocierii 1:n), One to One (unu la unu, apare, 
de obicei, la asocierea a două tabele prin câmpurile chei primare), sau 
Indeterminate (Indică faptul că asocierea nu este definită corect). Următoarea 
imagine explică principalele elemente ale ferestrei de modificare a ascierilor (Edit 
Relationship). 

 
 
 

Cheie 
primară 

Cheie 
externă 

Asocierea 



Baze de date – Microsoft Access 

Pagina 12 din 42 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dacă se bifează restricţia de integritate referenţială (Enforce Referential 
Integrity), linia care desemnează asocierea dintre cele două tabele va afişa 1 la 
capătul dinspre tabela primară şi semnul ∞ la capătul dinspre tabela externă. 
Această proprietate este permisă numai în cazul în care tipul asocierii este One To 
Many. Odată cu selectarea acestei proprietăţi, alte două proprietăţi ale asocierii pot 
fi activate: Modificarea în cascadă a câmpurilor legate (Cascade Update Related 
Fields), ce presupune faptul că orice modificare adusă câmpului cheie primară din 
cadrul asocierii, presupune modificarea automată a câmpului cheie externă, pentru 
toate înregistrările asociate, şi Ştergerea în cascadă a înregistrărilor legate 
(Cascade Delete Related Records), ce presupune ştergerea tuturor înregistrărilor 
asociate din tabela externă odată cu ştergerea unei înregistrări din tabela primară. 
 

2.4. Utilizarea tipului de date Lookup Wizard 
 

Pentru a uşura munca celor care vor trebui să încarce date în tabele, 
precum şi pentru a respecta restricţia de integritate referenţială (vezi definiţia), în 
cadrul aplicaţiei Microsoft Access a fost introdus tipul de date Lookup Wizard. Acest 
tip de date oferă posibilitatea de a alege dintr-o listă valorile cheilor externe dintr-o 
tabelă asociată, astfel încât aceste valori să se regăsească printre valorile cheii 
primare din tabela primară a asocierii. De exemplu: fiind date două tabele, Furnizori 
şi Facturi, în cadrul cărora Codul furnizorului este cheie primară în prima şi cheie 
externă în cea de-a doua, la încărcarea datelor în tabele, pentru cheia externă din 
Facturi se va afişa o listă care va cuprinde toate valorile încărcate pentru cheia 
primară din Furnizori. În acest fel, utilizatorul poate alege din listă doar aceste valori, 
respectând astfel restricţia de integritate referenţială. 

Pentru alegerea valorilor cheii externe dintr-o listă se procedează astfel: 
1. Se introduce denumirea câmpului cheie externă; 
2. Se alege tipul de dată Lookup Wizard; 

Nume 
tabel 

primar 

Nume 
câmp 
primar 

Nume 
tabel 

extern 

Nume 
câmp 
extern

Tipul asocierii 
Restricţia de integritate 
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3. Se parcurg paşii pe care asistentul îi afişează: 

a. Primul pas: Bifarea primei opţiuni, pentru preluarea datelor dintr-
un alt tabel sau o interogare; 

b. Al doilea pas: Precizarea tabelului din care face parte cheia 
primară de unde vor fi preluate datele în listă; 

c. Al treilea pas: Selectarea câmpului sau câmpurilor ale căror valori 
vor fi afişate în listă. Selecţia se face cu ajutorul butonului  
care selectează un singur câmp, sau  care selectează toate 
câmpurile din tabelul primar pentru afişarea lor. 

d. Al patrulea pas: Stabilirea lăţimii câmpului afişat; 
e. Al cincilea pas: Precizarea denumirii sau etichetei pe care câmpul 

cheie externă o va afişa. 
Pentru finalizare, la apăsarea butonului Finish, Access afişează un mesaj prin 

care vă va invita să salvaţi tabelul pentru ca modificările să fie efectuate. 
 

2.5. Încărcarea datelor în tabele 
 

Până acum am învăţat cum se face proiectarea tabelelor şi a asocierilor 
dintre acestea. Însă, aşa cum am precizat la început, tabelele sunt destinate pentru 
a stoca date în ele, date care să poată fi consultate sau actualizate ulterior. De 
aceea o etapă importantă în crearea bazelor de date constă în încărcarea tabelelor 
cu date coerente. Aceste date sunt introduse de la tastatură, fie direct în tabele, fie 
prin intermediul unor formulare create special pentru a asigura o interfaţă cât mai 
agreabilă şi uşor de utilizat. 

Pentru încărcarea datelor în cadrul tabelelor trebuie să se ţină cont de 
rapoartele dintre tabelele aflate într-una sau mai multe asocieri. Astfel, mai întâi vor 
fi înărcate date în tabelele care deţin, în cadrul unei asocieri, cheia primară, după 
care se va trece la încărcarea datelor în tabelele ce conţin cheile externe aferente, 
pentru a se respecta restricţia de integritate referenţială. De exemplu, o factură nu 
poate fi emisă pentru clientul X, dacă acest client nu există în baza de date. 

Încărcarea datelor se va face în modul de afişare a datelor în cadrul unui 
tabel. Pentru aceasta, se selectează tabelul în cauză, apoi, fie se efectuează dublu 
clic, fie se apasă butonul Open pentru deschiderea tabelelor. Înregistrarea introdusă 
se salvează automat în momentul în care cursorul va părăsi rândul acesteia. 
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2.6. Operaţii de căutare, filtrare şi sortare a datelor din tabele. 
 

La nivel de tabel, există posibilitatea de a sorta datele încărcate în tabele, în 
funcţie de un anumit câmp. Pentru a sorta datele dintr-un tabel, se poziţionează, mai 
întâi, cursorul în cadrul câmpului după care se va face sortarea, apoi, din meniul 
Sort, se alege una din opţiunile prezente: Sort Ascending sau Sort Descending. 

Pentru filtrarea datelor, există posibilitatea definirii unor filtre cu ajutorul 
metodei formularului (Record->Filter->Filter By Form), prin care se poate alege o 
valoare pentru unul sau mai multe câmpuri pentru care se aplică criterii de filtrare. O 
altă metodă este cea de filtrare prin selecţie. Pentru aplicarea acestei metode, mai 
întâi se poziţionează cursorul pe valoarea care se constituie drept criteriu de filtrare 
pentru câmpul respectiv, după care se alege opţiunea Record->Filter->Filter By 
Selection. Pentru a afişa toate înregistrările, mai puţin cele care nu îndeplinesc 
criteriul de filtrare precizat, se alege opţiunea Record->Filter->Filter Excluding 
Selection. 

Căutarea datelor din cadrul unui tabel se poate face prin apelarea meniului 
Edit ->Find.  
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Cap. 3. Obiecte de tip cerere din cadrul unei baze de date 
Access 

 
Interogarea unei baze de date este un proces foarte important pentru 

utilizatorii acestora, întrucât presupune regăsirea şi extragerea informaţiilor dorite de 
către utilizator. Pentru realizarea interogărilor, Access pune la dispoziţia utilizatorilor 
obiectele de tip Cerere (Query). Rezultatul cererii se prezintă sub forma unei foi de 
răspuns dinamic, foaie care nu mai există fizic după închiderea cererii. Aşadar, o 
cerere de interogare a bazei de date nu măreşte spaţiul ocupat în cadrul 
calculatorului dumneavostră de către baza de date. O cerere poate interoga date din 
cadrul unuia sau mai multor tabele, sau chiar din cadrul altor cereri. Câteva dintre 
destinaţiile care se pot da unei astfel de cerere de interogare a bazei de date sunt 
următoarele: 

 Regăsirea informaţiei în baza de date; 

 Efectuarea de calcule folosind date din tabelele bazei de date; 

 Actualizarea bazei de date; 

 Pregătirea datelor în vederea afişării lor în cadrul unor formulare 
sau rapoarte; 

 Realizarea unor reprezentări grafice. 
 
În Access, va trebui, de multe ori, să regăsim şi să analizăm informaţii din cadrul 
mai multor tabele ale bazei de date. Interogările pe tabele multiple, leagă date 
stocate în două sau mai multe tabele legate prin una sau mai multe asocieri, astfel 
încât aceste date să devină informaţii importante pentru analiză. 

În acest capitol, vom învăţa cum vom putea exploata puterea acestor 
interogări, care sunt principalele tipuri de cereri de interogare şi când şi cum pot fi 
ele folosite, pentru o bună exploatare a bazei de date. 

 

3.1. Tipuri de cerere pentru interogarea bazelor de date 
Access oferă posibilitatea construirii următoarelor tipuri de cerere: 

 Cereri de selecţie (Select Query), formează cel mai utilizat tip de 
cerere de interogare, care dau posibilitatea stabilirii de criterii de 
căutare, regăsirii informaţiei dorite şi afişării acestei informaţii pentru 
a fi accesibilă utilizatorului. Tot în această categorie se înscriu şi 
cererile prin care se afişează rezultatul unor calcule dintre valorile 
unor anumite câmpuri. La rândul lor, cererile de selecţie se împart în 
alte categorii mai mici: 

o Cereri de selecţie propriu-zisă: selectează date din unul sau 
mai multe tabele şi/sau interogări, pe baza unor criterii 
stabilite iniţial; 

o Cereri parametrizate: presupune filtrarea datelor din tabele 
sau interogări pe baza unor criterii precizate printr-un 
parametru, adică, o valoarea care se va stabili de către 
utilizator la executarea cererii; 
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o Cereri cu câmpuri calculate: afişează, pe lângă datele din 
tabele sau interogări, şi rezultatul unor calcule efectuate între 
valorile a două sau mai multe câmpuri, sau între acestea şi 
valori scalare; 

o Cereri de agregare a datelor: sintetizează date din tabele, 
utilizând funcţii de agregare a datelor dintr-unul sau mai multe 
câmpuri pentru mai multe înregistrări. 

 Cereri de analiză încrucişată, care permit sintetizarea datelor şi a 
rezultatelor obţinute din calcule, sub forma unei foi de calcul tabelar, 
făcând informaţia mai uşor de citit şi de înţeles. 

 Cereri de acţiune, care modifică date din cadrul tabelelor sau 
crează noi tabele, pe baza unor criterii. Cererile de acţiune se împart 
în următoarele subcategorii: 

o Cereri pentru crearea de noi tabele (Make Table Query): 
crează un nou tabel, cu toate înregistrările sau doar o parte a 
acestora, din unul sau mai multe tabele asociate; 

o Cereri pentru adăugarea de date în tabele (Append Query): 
adaugă anumite înregistrări dintr-un tabel în altul; 

o Cereri pentru modificarea datelor din tabele (Update 
Query): Modifică date dintr-un anumit tabel, în funcţie de 
anumite criterii precizate; 

o Cereri pentru ştergerea datelor din tabele (Delete Query): 
pe baza unui anumit criteriu, şterg înregistrările dintr-un 
anumit tabel. 

Oricare ar fi tipul cererii de interogare, orice obiect de tip cerere este supus 
următoarelor operaţii: 

 Operaţia de construire sau de creare a cererii; 
 Oeraţia de utilizare, deschidere sau afişare a datelor interogate; 
 Operaţia de modificare a definiţiei cererii realizate prin operaţia de creare. 

 

3.2. Crearea obiectelor de tip cerere 
Un obiect de tip cerere poate fi creat utilizând două modalităţi principale: prin 

proiectare grafică a cererii (cunoscut şi sub denumirea de Modul Design), şi prin 
utilizarea limbajului standard de interogare a bazelor de date (cunoscut sub 
denumirea de limbajul SQL – Structured Query Language). În prezentul capitol ne 
vom ocupa doar de prima modalitate, folosind interfaţa grafică Access.  

Toate obiectele de tip cerere sunt afişate în cadrul tipului de obiecte Queries, 
din cadrul ferestrei bazei de date. Pentru crearea unei cereri noi se procedează la 
apăsarea butonului New, sau apelarea meniului Insert->Query. Access oferă mai 
multe posibilităţi de creare de cereri, prezentate în caseta de dialog New Query, ce 
se afişează pe ecran, imediat după ce comanda de creare a unei noi cereri a fost 
dată. 
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Caseta de dialog afişează următoarele moduri de creare a unei noi cereri:  

 Modul grafic de proiectare, Design View; 
 Asistentul pentru cereri simple (Simple Query Wizard); 
 Asistentul pentru crearea tabelelor încrucişate (Crosstab Query 

Wizard); 
 Asistentul pentru căutarea înregistrărilor duplicat (Fiind Duplicates 

Query Wizard); 
 Asistentul pentru căutarea înregistrărilor care nu au corespondent în 

cele două tabele sursă (Fiind Unmatched Query Wizard). 
Deşi asistentul poate uşura munca celui care îl utilizează, în practică, cel 

mai des se utilizează prima modalitate de creare a cererilor, şi anume modul grafic 
de proiectare. 

3.2.1. Crearea cererilor de selecţie 
Pentru cererile de selecţie a datelor, se alege opţiunea Design View din 

caseta New Query. Access va afişa fereastra de interogarea a tabelelor după 
exemplu, cunoscută sub denumirea Query By Example (prescurtat Q.B.E.). Alături 
de acestă fereastră, se va afişa şi caseta de selectare a tabelelor care urmează a fi 
interogate, denumită Show Table. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
După cum se poate observa, această casetă pune la dispoziţia utilizatorilor 

posibilitatea de a crea cereri pe baza unor tabele, a unor alte interogări sau mixt, 
interogări şi tabele. Prin selectarea unui astfel de obiect şi apăsarea butonului Add 
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obiectul în cauză va fi adus în fereastra QBE pentru a se putea face interogarea 
datelor din cadrul său, în funcţie de anumite criterii. 

Fereastra QBE are următoarele componente: 
 

 
Grila de câmpuri conţine mai multe rânduri care au destinaţii diferite. 

Fiecare coloană din cadrul grilei este destinată unui anumit câmp din cadrul 
tabelelor aduse pentru interogare.  

Rândul Field din cadrul grilei se completează automat sau de la testatură cu 
denumirea unui câmp din cadrul tabelelor prezente.  

Rândul Table este destinat precizării tabelului din care face parte câmpul 
introdus în cadrul primului rând din grilă, având în vedere că aceeaşi denumire o pot 
lua două sau mai multe câmpuri, dar din tabele diferite. 

Rândul Sort oferă posibilitatea sortării datelor afişate la executarea 
interogării prin ordonarea crescătoare sau descrescătoare a celor din câmpul sau 
câmpurile unde se precizează sortarea. Valorile pentru acest rând pot fi alese dintr-
o listă derulantă. 

Rândul Show este destinat posibilităţii de afişare sau ascundere la 
executarea interogării a datelor din câmpul pentru care se selectează sau 
deselectează.  

Rândul Criteria prezintă importanţă prin prisma oportunităţilor oferite pentru 
filtrarea datelor din tabele. Aici şi în cadrul rândurilor care urmează vor fi introduse 
expresiile valide pe baza cărora se va efectua selectarea doar a acelor înregistrări 
care îndeplinesc criteriile precizate. Criteriile vor fi precizate utilizând anumiţi 
operatori de comparaţie sau logici. 

În continuare, vom prezenta câteva criterii de filtrare a datelor introduse cu 
ajutorul unor operatori. 

Operator Exemplu Descriere 
= =”Nicu” Caută valorile egale cu textul „Nicu” 
<> <>”Mere” Afişează toate valorile, mai puţin „Mere” 
< <10 Toate valorile câmpului mai mici ca 10 
>= >=2000 Toate valorile mai mari decât 2000 
Between Between 1/2/2000 And 5/3/2004 Toate datele cuprinse în intervalul precizat 
Like Like “S*” Caută toate valorile care incep cu litera S 

Panoul de 
tabele 

Grila de 
câmpuri 

Numele şi 
tipul 

cererii
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NOT NOT “Pere” Afiseaşă toate valorile diferite de „Pere” 
IN IN (5,8,4) Toate valorile de 5,8 sau 4 
IS NULL IS NULL  Caută înregistrările al cu valori nule 
IS NOT NULL IS NOT NULL Caută înregistrări care conţin valori 

 
Odată precizată sursa de date, definirea interogării de selecţie presupune 

parcurgerea următorilor paşi: 
1. Precizarea atributelor ale căror realizări urmează se le returneze cererea. 

Numele acestor atribute se vor preciza în grila Design View în rândul 
Field, utilizând unul dinre următoarele modalităţi: 

a. Selectarea atributului sin lista care apare în caseta Field Name; 
b. Efectuarea unui dublu click cu butonul stâng al mausului, pe 

denumirea câmpului din cadrul tabelului din panoul de tabele; 
c. Metoda Drag-and-Drop (apucă şi aruncă), care presupune 

selectarea cu mausul a câmpului dorit din panoul tabelelor şi 
„tragerea”, ţinând apăsat butonul stând al mausului, în dreptul 
liniei Field din grila de câmpuri. 

 
Există posibilitatea de a aduce în grila de câmpuri a tuturor atributelor unui 
tabel, prin efecuarea unui dublu clic pe semnul * care apare în tabelul 
respectiv. Acelaşi lucru se poate obţine şi dacă se efectuează un dublu clic 
pe denumirea tabelului din panoul superior, pentru a selecta toate câmpurile, 
şi utilizarea metodei „Drag and Drop” pentru a aduce toate aceste atribute în 
cadrul grilei. 

2. Precizarea criteriilor pentru acele câmpuri pentru care se doreşte 
filtrarea. Criteriile se precizează pe rândul Criteria sau Or utilizând 
expresii valide, care să fie înţelese de Microsoft Access. 

3. Stabilirea criteriilor de sortare aplicate anumitor câmpuri din cadrul grilei 
în dreptul rândului Sort. 

4. Debifarea opţiunii Show pentru acele câmpuri care nu se doresc a fi 
afişate la executare. 

 
Există posibilitatea ştergerii anumitor câmpuri din cadrul grilei de câmpuri, în situaţia 
în care nu le  mai considerăm necesare pentru interogare. Acest lucru se realizează 
prin poziţionarea cursorului deasupra denumirii câmpului în cauză, şi efectuarea 
unui clic când cursorul capătă forma unei săgeţi negre cu vârful în jos ( ). Apoi, 
pentru ştergere, se apasă tasta Delete. 

Lansarea în execuţie a cererii se realizează prin următoarele procedee: 
 Utilizând butonul Query View, , primul de pe bara de 

instrumente; 
 Utilizând butonul Run, , din bara de instrumente; 
 Din meniul View, se alege opţiunea Datasheet; 
 Din meniul Query, se alege opţiunea Run. 

 
Crearea cererilor parametrizate 
Cererile parametrizate presupun introducerea unei valori pentru criteriul 

unui câmp de către utilizator, în momentul în care interogarea este lansată în 
execuţie. Pentru aceasta, se procedează la crearea unei cereri de interogare de 
selecţie, parcurgând paşii pe care i-am prezentat, urmând să stabilim, în final, cărui 
câmp i se va atribui parametrul pentru filtrarea datelor.  
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Un parametru constă, de fapt, dintr-un text pe care calculatorul îl va afişa în 
momentul în care cererea este lansată în acţiune, text care va invita utilizatorul să 
introducă valoarea în urma căreia se va face filtrarea. Acest text va trebui, 
întotdeauna, introdus între paranteze drepte, pentru ca Access să-l recunoască 
drept parametru şi nu drept un criteriu stabilit anterior. De exemplu, se doreşte 
afişarea tuturor furnizorilor dintr-o localitate specificată de utilizator în momentul 
execuţiei. Fereastra QBE va arăta astfel: 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

La executarea cererii, Access va afişa o casetă de dialog în care va invita 
utilizatorul să precizeze care este valoarea parametrului, valoare ce va sta la baza 
filtrării înregistrărilor. 

 
 
 
 
 
 
 
 
 
 
 
Crearea cererilor cu câmpuri calculate 
 

Crearea unei interogări nu se limitează  numai la câmpurile tabelei sau tabelelor 
bazei de date. Se pot utiliza expresii pentru a crea câmpuri calculate. Aceste 
câmpuri pot fi rezultatul unor operaţii între două sau mai multe câmpuri, sau între 
unul sau mai multe câmpuri şi anumite valori scalare. Pentru a efectua operaţii 
cu aceste câmpuri, sunt folosiţi operatorii aritmetici (+, -, *, /) şi parantezele 
rotunde. Parantezele drepte sunt utilizate pentru desemnarea unui anumit câmp 

Parametrul introdus între 
paranteze drepte 

Câmpul asupra căruia se 
stabileşte criteriul

Câmp pentru 
introducerea valorii 

parametrului 
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(cu alte cuvinte, câmpurile trebuie trecute între paranteze drepte). Exemple de 
câmpuri calculate: 

 Se cunoaşte că Valoarea TVA=Valoare * Cota TVA. Această 
formulă se exprimă, în limbajul Access, în următoarea formă: 

 Valoare TVA: [Valoare] * [Cota TVA] 
Dacă renunţăm la câmpul Cota TVA şi ştim că aceasta este de 
19 %, atunci câmpul calculat are următoarea formulă: 
 Valoare TVA: [Valoare] * 19/100 

 
Aceste formule se introduc în grila de câmpuri, în următoarea coloană 

liberă, pe rândul Field. Eticheta câmpului calculat va fi dată de partea din stânga 
semnului „:”. În exemplul nostru, câmpul se va numi „Valoare TVA”. 

 
 
Crearea cererilor de agregare a datelor 
 
Access permite construirea cu uşurinţă a unor cereri care să returneze 

totalul unor atribute aparţinând unor înregistrări grupate după anumite criterii. 
Presupunând că avem două tabele:  

Facturi (NrFactura, DataFactura, CodFurnizor, CotaTVA) 
ProduseFacturate (NrFactura, CodProdus, Cantitate, Pret) 

şi că dorim afişarea totalului cantitativ pentru toate produsele din fiecare factură în 
parte, se va face gruparea  înregistrărilor după câmpul NrFactura din tabela 
ProduseFacturate şi se vor totaliza valorile câmpului Cantitate pentru fiecare grup în 
parte. 

Din punctul de vedere al aplicaţiei Microsoft Access, acest lucru se va 
traduce prin următorii paşi: 

1) Crearea unei interogări de selecţie în care se va aduce tabela 
ProduseFacturate; 

2) Aducerea în grila de câmpuri a atributelor NrFactura şi Cantitate; 

3) Selectarea opţiunii Total de pe bara de instrumente , care va afişa, 
în plus faţă de rândurile prezente în grila de câmpuri, un rând nou 
(rândul Total). 

4) În dreptul câmpului de grupare (în cazul nostru, NrFactura), se alege, 
pe rândul Total, opţiunea Group By. În dreptul câmpului de sintetizat, 
sau de agregare, se va alege, pentru acelaşi rând, o funcţie de 
totalizare, şi anume funcţia Sum (Sumă). În felul acesta, se vor însuma 
cantitaţile, pentru fiecare factură în parte. 

5) Se lansează în execuţie cererea de interogare pentru a vizualiza 
rezultatele obţinute. 

 
Fereastra QBE va arăta astfel: 
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3.2.2. Crearea cererilor de acţiune 
Cererile de acţiune sunt o categorie aparte a cererilor de interogare a 

bazelor de date, pentru că efectuează schimbări la nivelul bazei de date, aceste 
schimbări afectând atât structura tabelelor (interogări pentru crearea de noi tabele), 
cât şi datele conţinute de acestea (celelalte interogări de acţiune). De aceea, se 
impune să manifestăm o anumită prudenţă în lucrul cu aceste tipuri de cereri, 
întrucât rezultatul lor este iremediabil (odată şterse anumite înregistrări, ele nu mai 
pot fi recuperate). 

Specific acestor tipuri de interogări este faptul că ele trebuie lansate în 
execuţie doar prin comanda Run din meniul Query sau prin apăsarea butonului  
de pa bara de instrumente. 
 
 

Interogările generatoare de noi tabele (Make Table Query) 
 
Aceste interogări permit crearea unei noi tabele plecând de la datele 

stocate într-o altă tabelă, sau de la rezultatul unei interogări aplicate uneia sau mai 
multor tabele.  

Acest tip de interogare se poate crea urmând o anumită succesiune de 
paşi: 

a. crearea unei interogări de selecţie cu toate elementele ei 
(câmpuri sortate, criterii de filtrare, câmpuri calculate, sintetizări 
de date,etc.). 

b. transformarea acestei interogări în tipul de interogare pentru 
crearea de tabele. Acest pas constă în alegerea tipului de 
interogare Make Table Query din meniul Query. 

c. precizarea în cadrul casetei de dialog care apare a numelui 
tabelului nou creat, tabel care se va regăsi după executarea 
cererii de interogare în grupul de obiecte Tables. 

d. executarea cererii de interogare prin apelarea meniului Query- 
Run. 
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Cereri pentru modificarea datelor din înregistrările unui tabel (Update 
Query) 

 
Sunt utilizate pentru actualizarea înregistrărilor dintr-o tabelă, care 

corespund unui anumit criteriu. Pentru a se efectua actualizarea, trebuie să 
precizăm, la nivelul unei astfel de cereri, care este câmpul asupra căruia se aplică 
criteriul de modificare, care este câmpul ale cărui date vor fi modificate şi care este 
formula de modificare a acestor date, sau valoarea care se va stoca pentru câmpul 
de modificat. 

Pentru realizarea unei cereri de actualizarea a înregistrărilor, vom da un  
exemplu: Se cere să se modifice localităţile furnizorilor din Ploieşti în Bucureşti. Se 
va proceda în felul următor: 

 Se crează o interogare pe baza tabelei Furnizori; 
 Se alege atributul Localitate în grila de câmpuri; 
 Se schimbă tipul cererii în interogare de modificare, utilizând 

meniul Query->Update; 
 În cadrul grilei de câmpuri, care va conţine rânduri noi, diferite de 

cele prezentate anterior, se va trece pe rândul Criteria localitatea 
care trebuie modificată (în cazul nostru, Ploieşti), şi pe rândul 
Update To (Modifică în), localitatea nouă (în cazul nostru, 
Bucureşti); 

 Se execută interogarea prin apelarea meniului Query->Run. 
Fereastra QBE va arăta astfel: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pentru a putea vizualiza rezultatele, se va deschide tabelul Furnizori din 
grupul de obiecte Tables. 
 

Cereri pentru ştergerea înregistrărilor din tabele 
 
Pentru a şterge dintr-o tabelă anumite tupluri care îndeplinesc un anumit 

criteriu de selecţie, se pot defini interogări de acţiune. Procedaţi astfel: 
 Creaţi o interogare nouă pe baza tabelei în care se va efectua 
ştergerea înregistrărilor; 

 Aduceţi în cadrul grilei câmpul sau câmpurile pentru care se vor 
defini criteriile de selecţie şi precizaţi aceste criterii pe rândul Criteria; 
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 Schimbaţi tipul cererii din Select Query în Delete Query, utilizând 
meniul Query->Delete Query; 

 Lansaţi cererea în execuţie prin apelarea meniului Query->Run. 
 

De exemplu, pentru crearea unei cereri de ştergere a înregistrărilor din tabela 
facturi al căror număr este mai mic decât 5, fereastra QBE va fi afişată astfel: 
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Cap. 4. Obiecte de tip formular într-o bază de date Access 
 
Formularele sunt ferestre personalizate, care pot fi create cu ajutorul 

aplicaţiei Microsoft Access, utilizate pentru a asigura o interfaţă cât mai agreabilă 
pentru cel care actializează datele din tabele sau le vizualizează. În acest scop, un 
formular va conţine o serie de elemente vizuale (obiecte grafice) numite controale. 
La nivelul formularelor pot fi definite reguli de validare suplimentare celor definite în 
cadrul tabelelor. De asemenea, există posibilitatea definirii unor formulare care să 
preia datele din două sau mai multe tabele şi să le afişeze sau actualizeze 
împreună. 

Formularele din cadrul unei aplicaţii Access pot fi create în scopul de a afişa 
şi actualiza datele din cadrul unor tabele (le vom numi Formulare legate), care 
prezintă o sursă de date, sau pentru alte scopuri, cum ar fi afişarea unor mesaje, 
afişarea meniurilor aplicaţiei, deschiderea altor formulare sau rapoarte, etc. 
(formulare care se numesc Nelegate). 
 Obiectele de tip formular sunt grupate în categoria Forms din cadrul ferestrei 
bazei de date.  
 

4.1. Crearea formularelor legate 
 

Pentru uşurarea efortului de proiectare a unui astfel de formular, Access ne 
pune la dispoziţie o serie de asistenţi (Wizards), care ne invită să parcurgem anumiţi 
paşi în urmă cărora formularul va fi finalizat. Aceasta este cea mai uşoară cale 
pentru realizarea unui obiect de tip formular. Însă nu întotdeauna uilizatorul se 
mulţumeşte cu ceea ce asistentul a realizat. De aceea, el va trebui să apeleze la 
cea de-a doua metodă pentru crearea formularelor, şi anume, metoda de proiectare 
a acestora (Design View). 

Pentru crearea unui formular nou, fie se alege opţiunea Insert->Form, fie se 
apasă butonul New de pe bara de instrumente a ferestrei bazei de date. Oricare ar fi 
metoda aleasă, Access va afişa o casetă (New Form), prin care invită utilizatorul să 
aleagă modalitatea prin care formularul va fi creat. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modalitatea 
de creare a 

formularului

Lista pentru 
alegerea sursei 
formularului 



Baze de date – Microsoft Access 

Pagina 26 din 42 

Din lista de modalităţi afişate se va selecta cea dorită pentru crearea 
formularului: 

 Design View – toate operaţiile de proiectare vor fi stabilite de 
utilizator; 

 Form Wizard  - utilizatorul va fi îndrumat pas cu pas în crearea 
formularului; 

 AutoForm: Columnar – Se va genera automat un formular în 
care câmpurile din tabel vor fi dispuse pe orizontală; 

 Autoform: Tabular – se generează un formular în care câmpurile 
sunt dispuse pe verticală, sub formă de tabel; 

 Autoform: Datasheet – se va genera un formular de tip foaie de 
calcul (asemănător unui tabel sau interogare); 

 Chart Wizard – se va crea un formular ce va afişa datele sub 
forma unui grafic; 

 Pivot Table Wizard – se va genera un formular sub forma unei 
tabele pivot generată prin aplicaţia Excel; 

 
Foarte frecvent se foloşeste, într-o primă fază, unul din asistenţii prezentaţi 

mai sus, după care formularele generate de aceştia sunt deschide în modul Design, 
pentru a fi modificate, astfel încât acesta să corespundă cât mai bine cerinţelor 
utilizatorului final. 

 
Crearea formularelor legate cu ajutorul asistentului 
 
Proiectarea formularelor utilizând varianta Form Wizard presupune 

parcurgerea anumitor paşi, atunci când sursa de date este o tabelă: 
1. În fereastra Form Wizard se va selecta mai întâi tabelul sau 

tabelele care vor sta la baza afişării datelor din cadrul 
formularului, după care se vor preciza care sunt câmpurile care 
vor apărea în cadrul acestuia. 

 

Sursa 
formularului 

Câmpurile 
din cadrul 

sursei 
selectate 

Butoane de 
selecţie 

Lista cu 
câmpurile ce 
vor apărea în 

formular 
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Tipuri 
predefinite 

de 
formulare 

2. Se alege tipul de formular dorit, precizându-se modul în care vor 
fi afişate datele. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Selectarea stilului dorit pentru formular. Access pune la 

dispoziţie o listă predefinită de şabloane pentru formularul în 
cauză. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Definirea titlului formularului, precum şi modul în care va fi 
deschis acesta (pentru vizualizarea datelor sau pentru 
modificare). 
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Crearea formularelor în modul de proiectare 
 
Modul de proiectare al formularelor este mai muţin utilizat, însă oferă 

posibilitatea modificării aspectului acestora sau stabilirii de reguli suplimentare de 
validare a datelor. 

Structura unui formular este descrisă în modul de proiectare. Orice formular 
conţine 3 secţiuni importante, secţiuni în care vor fi desenate controalele şi ulterior 
încarcate cu date. Acestea sunt:  

 Secţiunea de antet a formularului (Form Header), folosită, în general, 
pentru a afişa titlul formularelor, sau alte informaţii referitoare la 
folosirea acestuia. 

 Secţiunea de detaliu a formularului (Detail), este zona care va 
conţine toate controalele necesare afişării datelor sau a altor acţiuni 
cu privire la acestea. 

 Secţiunea de subsol a formularului (Form Footer), zona care apare 
în partea de jos a formularului şi poate conţine diverse informaţii, 
cum ar fi totalul general, sau diverse controale. 

În plus, orice formular conţine bara de navigare care prezintă butoanele de 
deplasare prin înregistrări (prima înregistrare, înregistrarea anterioară, înregistrarea 
următoare, ultima înregistrare şi butonul pentru adăugarea unei noi înregistrări).  

Butoanele de navigare sunt afişate numai în timpul execuţiei formularului. 
 

 
 
 
 
 
 
 
 
 
 
 

Odată cu deschiderea formularului în modul Design, apare bara de 
instrumente Toolbar, care conţine toate controalele pe care utilizatorul le poate 
ataşa unui formular.  

 
 
 
 
 
 

 
Alături de aceste controale, această bară de instrumente prezintă un buton 

pentru activarea asistentului pentru acele controale pentru care există posibilitatea 
afişării lui. Dacă acest buton este activat, atunci asistentul va fi afişat de fiecare dată 
când utilizatorul plasează un astfel de control pe suprafaţa formularului. 

Pentru ataşarea unui control în cadrul unui formular, se efectuează clic pe 
pictograma controlului dorit, cursorul va căpăta forma semnului plus, urmând ca 
utilizatorul să traseze suprafaţa pe care o va ocupa controlul în cadrul formularului.  

Controalele 
formularului 

Bara de 
navigare

Selectorul de 
înregistrări 

Caseta de control a 
formularului 

Butonul pentru afişarea 
asistenului pentru 

controale 
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Dintre controalele puse la dispoziţia utilizatorului, cele mai importante sunt 
casetele text (Textbox) şi casetele derulante (Combobox), utilizate pentru afişarea 
datelor din cadrul câmpurilor sursei de date. Alături de acestea sunt utilizate şi 
etichetele (Label), pentru afişarea denumirilor de câmpuri, sau butoanele de 
comandă (Command button), pentru executarea diverselor acţiuni, de deplasare 
prin înregistrări, de adăugare, modificare sau ştergere a înregistrărilor din tabela 
sursă. 

Fiecare control poate fi deplasat oriunde pe suprafaţa formularului şi poate 
fi redimensionat, cu ajutorul mausului, prin poziţionarea acestuia în diverse zone ale 
marginii controlului, selectat în prealabil. 

Prin trasarea butoanelor de comandă pe suprafaţa formularului, Access 
afişează asistentul care oferă posibilitatea de a defini anumite acţiuni pentru butonul 
de comandă nou creat. Prin parcurgerea paşilor acestui asistent, butonului de 
comandă i se va ataşa un cod care va executa acţiunea aleasă la proiectare.  

1. Precizarea categoriei de acţiuni şi a acţiunii pe care trebuie să o 
execute butonul de comandă la efectuarea unui clic pe suprafaţa 
lui, în momentul execuţiei formularului. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Precizarea textului sau pictogramei care va fi afişat/afişată pe 

suprafaţa butonului de comandă. 
 
 
 
 
 
 
 
 
 
 

Lista cu 
categoriile de 

acţiuni 
Lista cu acţiunile 

categoriei 
selectate 

Caseta 
pentru 

introducerea 
textului 

Lista pentru 
selectarea 

pictogramei 
dorite 

Vizualizarea 
pictogramei 
selectate sau 

a textului 
introdus 



Baze de date – Microsoft Access 

Pagina 30 din 42 

 
 
 

3. Precizarea numelui butonului de comandă, cu care va fi 
identificat în cadrul formularului. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Prin apăsarea butonului Finish, butonul de comandă va fi creat, iar în 

momentul vizualizării formularului, la efectuarea unui clic, butonul de comandă va 
executa acţiunea precizată la proiectare. 

Fiecare formular, fiecare secţiune a formularului şi fiecare control din cadrul 
său deţine un set de proprietăţi, grupate în cinci mari categorii de acţiuni: 

a. Categoria Format, ce conţine proprietăţi cu privire la modul de 
afişare a formularului sau controalelor din cadrul său; 

b. Categoria Data, ce grupează toate proprietăţile care se referă la 
sursa de date a formularului sau controalelor; 

c. Categoria Event, grupând toate evenimentele la care formularul 
sau controalele pot răspunde; 

d. Categoria Other, ce conţine toate celelalte proprietăţi care nu se 
regăsesc în primele trei categorii; 

e. Categoria All, ce grupează toate proprietăţile prezente în primele 
patru categorii. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Categoriile de 
priprietăţi 
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Aceste proprietăţi sunt diferite pentru fiecare control în parte, dar indiferent 
care ar fi acestea, categoriile în care ele sunt grupate sunt aceleaşi. 

Setarea unei proprietăţi se poate face fie prin tastarea valorii respective, fie 
prin selectarea valorii dintr-o listă derulantă, fie cu ajutorul asistentului, care poate fi 
invocat prin apăsarea butonului Build Wizard. 

Pentru a afişa caseta de proprietăţi a formularlui, trebuie să efectuăm dublu 
clic pe caseta de selecţie a acestuia, situată între cele două rigle din cadrul 
formularului deschis în modul de proiectare. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pentru afişarea casetei de proprietăţi a unui control, se selectează mai întâi 

controlul respectiv, după care se efectuează clic dreapta pe suprafaţa controlului 
selectat şi se alege opţiunea Properties. 

 
Crearea câmpurilor calculate într-un formular 
 
În unele cazuri, este necesar să afişăm informaţii obţinute pe baza 

calculelor dintre două sau mai multe câmpuri din sursa de date a formularului. De 
exemplu, dacă se doreşte afişarea datei rezultate prin adunarea a 10 zile la data 
fiecărei facturi în parte, trebuie creat un câmp calculat care să fie afişat în cadrul 
formularului. Acest câmp poate fi creat parcurgând anumiţi paşi: 

1. Din caseta de instrumente Toolbox, se selectează tipul de 
control Casetă Text (Textbox), şi se ataşează formularului 
curent. Această casetă text nu prezintă o sursă de date, deci 
este un control nelegat. 

2. Se afişează proprietăţile acestui control şi în categoria Data, se 
poziţionează cursorul în caseta proprietăţii Control Source. 

3. Se tastează formula: =[DataFacturii]+10 
4. Se lansează în execuţie formularul (prin apelarea meniului View-

Form View), pentru a vizualiza rezultatul obţinut. 
 

Proprietăţile casetei text, precum şi formula introdusă pentru sursa de date 
a controlului, sunt afişate în imaginea care urmează: 

 
 

Caseta de 
selecţie a 

formularului 
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La vizualizarea formularului, rezultatul va fi afişat după cum urmează: 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.2. Crearea formularelor nelegate 
 

După cum am precizat, un formular nelegat se caracterizează prin faptul că 
nu prezintă o sursă de date care să stea la baza lui, adică nu există o legătură între 
un tabel sau interogare din cadrul bazei de date şi formularul în cauză. 

Dintre proprietăţile unui formular, există una care ne oferă posibilitatea să 
transformăm oricând un formular nelegat într-un formular legat. Aceasta este 
proprietatea Record Source, din categoria Data. Putem alege sursa de date din lista 
de tabele sau interogări care va fi afişată sau putem construi o sursă de date pe 
baza a mai multor tabele sau interogări, cu ajutorul asistentului pentru această 
proprietate. 
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afişată pentru 

câmpul calculat
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interogări deja create 

Buton pentru lansarea 
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Orice formular nelegat nu poate fi proiectat decât utilizând modul Design 
View. Nu putem crea formulare nelegate cu ajutorul unui asistent. De aceea, pentru 
a putea realiza un astfel de formular, trebuie să ştim foarte bine să ataşăm controale 
formularului şi să stabilim proprietăţile acestor controale, astfel încât rezultatul să fie 
cel dorit. 
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Cap. 5. Obiecte de tip raport într-o bază de date Access 
 

Este uşor să imprimăm o simplă listă de înregistrări dintr-un tabel sau 
interogare. Pur şi simplu vom deschide obiectul Access respectiv şi vom apela 
meniul File->Print. Însă, dacă dorim ca situaţiile noastre să apară într-o formă mai 
atractivă, mai profesională, dacă vrem să includem calcule sau să creăm anumite 
grafice pe baza datelor din tabele sau interogări, sau dacă dorim ca un antet sau un 
subsol personalizat să apară pe fiecare pagină din situaţia noastră, atunci trebuie să 
creăm un obiect de tip raport.  

Rapoartele sunt, deci, obiecte din cadrul unei baze de date Access care 
sunt destinate imprimării pe suport de hârtie şi care fac ca datele din tabele sau 
interogări să fie afişate într-o formă cât mai plăcută, uşor de înţeles şi uşor de 
analizat. 

Un obiect de tip raport pune la dispoziţia celui care îl proiectează unele 
avantaje: 

 Opţiuni de formatare atractive: Putem schimba tipul, mărimea 
sau culoarea fontului utilizat în cadrul rapoartelor, pentru a le face mai 
uşor de citit. Putem adăuga linii, casete text, sau imagini grafice în 
cadrul raportului. 

 Opţiuni de sortare şi grupare a datelor după diverse câmpuri: 
Rapoartele din Access sunt un instrument puternic pentru totalizarea 
şi organizarea informaţiilor pe grupuri de date. 

 Opţiuni de combinare a datelor din mai multe tabele legate: un 
singur raport poate afişa date din mai multe tabele sau interogări care 
conţin câmpuri de legătură, sau între care există deja creată o 
asociere. 

 
Acest capitol descrie care sunt posibilităţile de creare a obiectelor de tip 

raport dintr-o bază de date Access şi care ar fi principalele avantaje pentru care ar 
trebui să folosim un anumit tip de raport pentru prezentarea unor situaţii diverse. 

 
 

5.1. Crearea obiectelor de tip raport 
 

Rapoartele se aseamănă, din punct de vedere al proiectării lor, cu 
formularele. Pentru afişarea datelor din tabele sau interogări se utilizează controale 
de tip casete text, pentru afişarea denumirilor de câmpuri se folosesc controale de 
tip etichetă, iar pentru afişarea anumitor imagini grafice, controalele de tip imagine 
(Image). Însă, dat fiind faptul că scopul acestor obiecte diferă de acela al 
formularelor, în sensul că ele nu pot executa anumite operaţii care să se declanşeze 
la apariţia unor evenimente (de exemplu, la efectuarea unui clic cu mausul), atunci 
este uşor de înţeles că anumite controale destinate executării anumitor acţiuni nu-şi 
au sensul în cadrul unui astfel de obiect, întrucât ele vor fi tratate ca simple imagini, 
şi nu-şi vor executa acţiunile pentru care au fost create. În categoria acestor 
controale intră butoanele de comandă, casetele derulante sau butoanele de opţiune 
(Option Button). 
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Însă toate elementele prezentate pentru crearea formularelor vor fi 
asemănătoare cu cele pe care le vom învăţa pentru crearea obiectelor de tip raport. 

Obiectele de tip raport sunt grupate în categoria Reports din cadrul ferestrei 
bazei de date. 

 
Pentru a crea un raport nou, fie se apelează meniul Insert->Report, fie se 

apasă butonul New de pe bara de instrumente, situată în cadrul ferestrei bazei de 
date. Se va deschide automat o casetă de dialog care ne va invita să alegem 
opţiunea dorită pentru crearea raportului şi, de asemenea, în situaţia în care vom 
crea un raport legat (care să preia date dintr-unul sau mai multe tabele sau 
interogări), să precizăm şi care este sursa de date care va sta la baza creării lui. 

Fereastra pentru crearea  unui raport nou are următoarele părţi 
componente: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La deschiderea acestei ferestre, Access ne afişează o listă cu modalităţile 

posibile de creare a rapoartelor. Această listă ne pune la dispoziţie atât metoda de 
proiectare Design View, cât şi diverşi asistenţi care ne vor ghida în realizarea 
rapoartelor dorite. Vom explica, în continuare, care sunt scopurile fiecărei metode în 
parte: 

 Design View: utilizatorul va trebui să creeze propriul raport fără nici un 
ajutor din partea vreunui asistent. Proiectarea raportului se va face 
utilizând controalele şi proprietăţile acestora. 

 Report Wizard: crearea rapoartelor standard se va face prin 
parcurgerea anumitor paşi la finalul cărora se va afişa raportul dorit. 

 AutoReport: Columnar: se generează automat un raport pe baza unei 
surse de date selectate din lista cu tabelele şi interogările bazei de 
date, în care denumirile câmpurilor şi valorile acestora sunt dispuse pe 
orizontală. 

 AutoReport: Tabular: se va genera un raport pe baza unei anumite 
tabele sau interogări din baza de date, în care câmpurile acesteia sunt 
dispuse pe orizontală (sub formă tabelară). 

 Chart Wizard: oferă posibilitatea creării unui raport în care datele din 
tabele sau interogări vor fi afişate sub forma unui grafic. 

 Label Wizard: asistent pentru generarea unui raport pentru etichete. 
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5.1.1. Generarea rapoartelor cu ajutorul asistentului (Report Wizard) 
 

Cea mai simplă modalitate, şi în acelaşi timp şi cea mai utilizată, pentru 
crearea unui raport, este utilizarea asistentului Report Wizard. Acesta prezintă o 
succesiune de paşi, al căror număr diferă în funcţie de numărul de tabele sau 
interogări  care stau la baza raportului. La finalul acestor paşi se va afişa raportul 
dorit, cu toate informaţiile specificate în cadrul său. 

Paşii pe care utilizatorul trebuie să-i parcurgă conţin o serie de întrebări la 
care acesta trebuie să răspundă şi care se concretizează în opţiunile sale pentru 
raportul dorit. Dat fiind faptul că numărul de paşi este mai mare în situaţia în care 
raportul are ca sursă de date mai mult de o tabelă sau interogare, vom prezenta în 
continuare crearea unui raport pe baza a două tabele (Facturi şi ProduseFacturate): 

1. Precizarea sursei raportului şi a câmpurilor pe care acesta le va 
conţine. 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
2. Modul de organizare a datelor din raport, precizând care este tabela în 

funcţie de care vor fi grupate datele. Între tabelele sau interogările sursei de 
date trebuie să existe câmpuri de legătură. 
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3. Precizarea câmpurilor suplimentare în funcţie de care se va face gruparea 
datelor în cadrul raportului. (Datele vor fi afişate sub forma unor grupuri 
pentru aceeaşi valoare a câmpului de grupare). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Sortarea datelor în cadrul raportului. De reţinut că orice câmp pentru care s-a 
făcut gruparea datelor este în acelaşi timp şi câmp de sortare, deci automat 
valorile sale vor fi sortate crescător. Există posibilitatea de a efectua sortarea 
datelor pe patru nivele, adică se va trece la sortarea de pe nivelul următor, 
numai dacă valorile câmpului curent de sortare sunt egale. Sortarea se poate 
face crescător sau descrescător. 
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5. Alegerea modului de aranjare în pagină a datelor. Access ne pune la 
dispoziţie, pentru rapoartele cu sursă de date formată din mai mult de o 
tabelă, şase posibilităţi de aranjare a câmpurilor şi valorilor acestora în cadrul 
raportului. În funcţie de numărul câmpurilor sursei de date, el poate opta 
pentru una din aceste opţiuni. De asemenea, tot aici, putem preciza şi cum 
va fi imprimat raportul (pe orizontală – Landscape, sau pe verticală – 
Portrait). 
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6. Alegerea unui stil pentru formatarea datelor din cadrul raportului. Există şase 
stiluri predefinite pe care Access le oferă utilizatorilor pentru ca datele din 
cadrul raportului să fie câ mai uşor de înţeles şi de urmărit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Definirea numelui raportului, precum şi precizarea modului în care acesta va 
fi deschis (pentru proiectare sau pentru vizualizarea datelor). 
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5.1.2. Modul de proiectare Design View 
 

De multe ori, asistentul pentru crearea rapoartelor se dovedeşte a fi 
suficient pentru a realiza situaţiile dorite. Însă, uneori, este necesar să modificăm 
structura unui astfel de raport pentru a adăuga noi date sau pentru a modifica modul 
de afişare a informaţiilor din cadrul său. Pentru această trebuie să deschidem 
raportul în modul de proiectare a acestuia. 

Vom observa ca orice raport conţine cinci secţiuni standard, în cadrul 
cărora vor fi incluse controale pentru afişarea informaţiilor. Este important să 
cunoaştem aceste secţiuni, întrucât ele apar în mod diferit în cadrul unui raport, iar 
includerea unui control într-una din aceste secţiuni va conduce la apariţia controlului 
respectiv doar când această secţiune va fi afişată în raport.  

Cele cinci secţiuni standard din cadrul unui raport sunt: 
1. Antetul raportului (Report Header). Este secţiunea care apare 

o singură dată la afişarea raportului, la începutul acestuia, 
precedând orice informaţie conţinută de celelale secţiuni. 

2. Antetul de pagină (Page Header). Apare pe fiecare pagină, la 
începutul acesteia, afişând controalele conţinute în cadrul său, o 
singură dată pentru fiecare pagină. 

3. Conţinutul raportului (Detail). Conţine toate informaţiile afişate 
prin intermediul controalelor din cadrul său. Această secţiune are 
proprietatea de a se repeta de fiecare dată când întâlneşte o 
înregistrare nouă, astfel încât toate înregistrările din cadrul 
sursei de date să fie afişate în cadrul său. 

4. Subsolul de pagină (Page Footer). Este secţiunea care apare 
în cadrul fiecărei pagini, o singură dată pe pagină, la finalul 
acesteia. 

5. Subsolul raportului (Report Footer). Această secţiune afişează 
controalele din cadrul său la sfârşitul raportului. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Toate aceste cinci secţiuni apar în mod obligatoriu la nivelul unui raport. Însă, 
uneori, în cadrul ferestrei Design View ale raportului mai apar şi alte secţiuni, în 
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unui raport 
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urma stabilirii unor criterii de grupare a datelor din raport, fiecare câmp de grupare 
fiind însoţit de un antet de grupare şi un subsol de grupare. 

 
Toate controalele conţinute de către un raport pot fi redimensionate, mutate 

sau li se pot aplica diverse formate pentru afişarea în mod diferit a datelor din tabele 
sau interogări. La fel ca şi în cazul formularelor, fiecare raport, control sau secţiune 
de raport deţine un set de proprietăţi care pot fi modificate în fereastra de proiectare. 
Aceste proprietăţi sunt grupate în aceleaşi categorii ca şi la formulare. Modalităţile 
de afişare a acestor proprietăţi au fost prezentate în capitolul anterior. 

 

5.2. Vizualizarea rapoartelor şi imprimarea acestora 
 

Dat fiind faptul că principalul scop pentru care au fost create este acela de a 
prezenta informaţia pe suport de hârtie într-o formaă cât mai agreabilă, rapoartele 
pot fi imprimate şi pot fi vizualizate înaintea imprimării. Vizualizarea unui raport se 
face prin simpla deschidere a acestuia (dublu clic pe pictograma raportului sau 
selectarea acestuia şi apăsarea butonului Open de pe bara de instrumente a 
ferestrei bazei de date). 

Imprimarea raportului se poate face apelând meniul File->Print. Se 
deschide fereastra de dialog Print, prin care pot fi stabilite diverse posibilităţi de 
imprimare a acestuia. În plus, ca în orice aplicaţie Office, există opţiunea Page 
Setup, în cadrul meniului File, care dă posibilitatea stabiliriirii caracteristicilor de 
imprimare, cu privire la marginile raportului, la dimensiunile şi aranjarea paginii sau 
la imprimarea pe coloane. 
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